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WELCOME TO MULTI-AD CREATOR2™!
Welcome to Multi-Ad ™! While you might not
recognize the Multi-Ad Services name, it has provided
desktop layout software—like Creator®—to newspapers
and advertisers for years. Multi-Ad Services has a tradi-
tion of providing fast, reliable, intuitive, and powerful
software. is no exception.

At its core, is a Macintosh application. If you
have never used a Macintosh before, you will find the
application to be simple, elegant, powerful, and intuitive.
If you have used a Macintosh, the user inter-
face is instantly recognizable. For example, it uses many
traditional keyboard shortcuts—Cmd-P for Print, Cmd-
Shift-B for boldface type, and so on.

Note: You can differentiate references to menus, sub-
menus, and buttons from references to command
keys, check boxes, pop-up menus, and other
options. Menus, submenus, and button references
appear in the Chicago font. Command keys, check
boxes, pop-up menus, and other options appear in
the Geneva font.

If you have never used a Macintosh computer, or desktop
publishing programs in particular, you should read this
User’s Guidebefore using . This Guide intro-
duces you to the basic features, interface, and terminol-
ogy of the application. For more information on a specific
feature, refer to The Reference Manual. The
Reference Manualprovides in-depth descriptions of each
of ’s commands and features.

Whatever your design needs, gives you the
most powerful set of tools and features available without
sacrificing ease of use. We hope you enjoy using

. If you have any questions, comments, or reac-
tions, please let us know!
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To use the application effectively, you need to understand
each element that appears on the screen. The first section
of the User’s Guideexplains screen elements.
Both beginners and longtime computer users can benefit
from reviewing the material in the first half of this guide. 

You may already use a Macintosh or have some knowl-
edge of its interface and screen elements. However,

has many unique elements you should know
about. You also may have used Multi-Ad Creator; while

borrows many elements from Creator, many
elements have changed and much has been added. 

Reading the sections that introduce ’s appear-
ance can help you learn about how the program works
and get you using the application more quickly.

THE CREATOR2 SCREEN

The Document Sizes Dialog Box

The New Document dialog box is the first item that
appears after you launch the application. The
New Document dialog lets you set the dimensions (width
and depth) of each page in your document. The dialog
provides you with a variety of options. You can set the
document size by entering the document’s width and
depth in the appropriate text fields. Or choose a preset
document size by clicking the Choose Page Size… but-
ton. Clicking this button opens the Choose a Size dialog
box. Choose a set of sizes from the Set pop-up menu.
Select a size from the scroll list and click the OK button to
return to the New Document dialog box.
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The default preset sizes available include:

• SAU (Standard Advertising Unit) Sizes
SAU sizing is the established system of document
sizing for the newspaper industry. An SAU column
is 2 1/16 inches wide, so a 1 x 3 SAU document is 2
1/16 inches wide and 3 inches deep.

• TMAU (Television Magazine Advertising Unit) Sizes
TMAU is a database of document sizes designed
for creating a standard for advertisers in television
listing magazines.

• Other Sizes
This includes commonly used sizes for letters and
business cards. 

In addition to the provided document sizes, you can add
sizes you frequently use to the Choose a Size dialog box.
You can do this in the Document Sizes panel of the
Preferences dialog box in the Edit menu.

After you have chosen your document’s dimensions, the
Document Window appears. As you can see, the Document
Window has much in common with the standard Macintosh
window; however, you may not recognize all the features.

The Document Window

Document Window

Tools palette

Colors palette

Styles palette

Files palette

Font Specs palette Element Specs palette



The ability to print documents on different size sheets of
paper can prove helpful, especially in .

lets you create documents of any page size,
even sizes that you don't have in your printer's paper
trays. To help you distinguish between the document's
page size and the printer's paper size, places
several rectangles in your Document Window.

The white area centered in the Document Window is, of
course, your document's page size. However, this can be
larger or smaller than your printer's paper. The blue out-
line represents the sheet size of the selected paper. The
red, inner outline represents the printable area of the
selected paper size.

The paper size and printable area size outlines reflect the
paper size selected in the Page Setup dialog box in the
File menu. If you change the selected page size, the size
of the paper outlines change also.

4 Multi-Ad Creator2

Paper size
outline

Paper's printable
area outline

Document page size/
Document Area

Printable Area and Paper Outlines
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The Desk Area is the light gray area surrounding the
Document Area. This area serves as a pasteboard for plac-
ing elements you don’t immediately need. These elements
don't print unless they sit inside the paper outlines and
you have the Bleed items at edge 4 selected (in the Page
Options panel of the Document Settings dialog box in the
Document menu). You can put elements on the Desk Area
simply by dragging them there.

The Desk Area

The Title Bar

The Title Bar appears at the top of every Document
Window. It displays the name of the document, group, or
container you currently have open.

The menu bar has several menus familiar to
any Macintosh user: the  (Apple) menu, the File menu,
the Edit menu, the Font menu, the Style menu, and the
Size menu. adds many new menus that
include: the Elements menu, the Arrange menu, the

The Menu Bar

The white rectangular area in the center of the window is
the Document Area. Think of the Document Area as

’s representation of a page. As such, it reflects
the dimensions you selected in the New Document dialog
box. More than one page may appear in a Document win-
dow at a time. In these instances, the Document Area
resizes to represent two facing pages. 

Place the elements of the document you want to create in
the Document Area. If you send a page to the printer,

prints only those elements you placed in the
Document Area. To print elements outside the Document
Area, refer to the Page Setup command entry in the

Reference Manual.

If your needs change, you can change the document's
dimensions.

The Document Area
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Format menu, the Document menu, and the View menu.
These menus offer specialized options for manipulating,
formatting, viewing, and publishing a document.

All of ’s menus organize command options logi-
cally according to their function. The application always
displays the menu items; if you cannot use the commands
in a menu, that menu appears dimmed. When you pull
down a menu, notice that some commands appear dimmed.
You cannot use these commands until you have performed
a specific action: you may need to draw an element, high-
light text, or select a particular tool.

The commands available under each menu include:

• menu
Access to desk accessories, control panels, the
Chooser, aliases, and so forth.

• File menu
Access to New…, Open…, Close, Save, Save As…,
Save Default Document Settings, Place
Graphic…, Import Text…, Export, Page Setup…,
Print…, and Quit commands.

• Edit menu
Access to Undo, Redo, Cut, Copy, Paste, Clear,
Select All, Duplicate…, Make Matrix…, Copy
Type Specs, Paste Type Specs, Copy ¶ Specs,
Paste ¶ Specs, Find/Change, and Preferences…
commands.

• Elements menu
Access to Element Info, Open Element, Make
Element Style…, Trapping, Convert Text to
Paths, Convert to Single Path, Mask Graphic,
Pen Weight…, Frame Type, Frame Texture…, Fill
Texture…, Fill Gradient…, Shadow Options…,
Shadow Texture…, Shadow Gradient…, Lock, and
Unlock commands.

• Arrange menu
Access to Bring to Front, Send to Back, Move
Forward, Move Backward, Center Horizontal on
Page, Center Vertical on Page, Wrap Text…, Fit
Text Block, Flip Horizontal, Flip Vertical, Group,
Ungroup, Arrangement, Element Specs, Guides…,
and Setup Guides… commands.
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• Style menu
Access to the Plain Text, Embolden, Italicize,
Outline, Shadow, Condense, Extend, Superior,
Inferior, Superscript, Subscript, Upper Case, and
Lower Case commands.

• Format menu
Access to Font Specs, Alignment, Language,
Hyphenation, Discretionary Hyphen, Insert Page
Number, "Smart Quotes", Character…,
Paragraph…, Copy Fit…, Size/Leading…,
Tracking…, Horiz. Scale…, Offset…, Make Type
Style…, Make ¶ Style…, Make Style Model…,
and Apply Tags commands.

• Document menu
Access to Document Settings…, Page Manager…,
Master Spreads…, Colors…, Element Styles…,
Text Styles…, Check Spelling…, Check
Selection…, Spelling Rules…, User
Dictionaries…, Replace Fonts…, and File
Utilities… commands.

• View menu
Access to New Window, Actual Size, Fit in
Window, Enlarge, Reduce, Separation, Rulers,
Guides, Arrange Palettes, Tools, Colors, Files,
Styles, Font Specs, Element Specs, Arrangement,
and Trapping commands.

Keyboard access to commands

When you feel comfortable using , you may
want to bypass the menu bar and execute certain menu
commands by their keyboard shortcut keys. Keyboard
shortcuts allow you to keep your hands on the keyboard
and significantly increase your design speed.

If you have already used other applications on the
Macintosh, you may already know some shortcut keys.

uses many of the same shortcut keys as other
programs. Should you want to know the shortcut key for
a particular command, they appear next to the commands
in the pull-down menus.



The Page pop-up menu
The Page pop-up menu lets you quickly advance to a
specified spread. A spread can contain one or two pages.
Click on the pop-up menu next to the bottom scroll bar
and select the appropriate page from the menu.

immediately takes you to the selected page or
master spread.

The Previous Spread and Next Spread buttons

The Previous Spread and Next Spread buttons move you
to the previous set of pages or the next set of pages with-
out using the scroll bars. If you are on the first page of a
document, the Previous Spread button appears dimmed.
If you are on the last page of a document, the Next
Spread button appears dimmed.

Previous
Spread

Next
Spread

The Rulers
The rulers appear at the top and left sides of the
Document Window. You can hide the rulers by deselecting
the Rulers command in the View menu.

You can set the rulers’ units in the Preferences dialog
box in the Edit menu. Select the General panel in the
scroll list at the left of the dialog box. Then choose your
desired ruler units from the Horizontal and Vertical pop-
up menus.

8 Multi-Ad Creator2

The View Area
The View Area always appears in the lower left-hand cor-
ner of the Document Window. The View Area provides
several different controls: You can choose the viewing
scale, zoom in or out, and enter your own view scale. To
enter your own view scale, choose the Other Scale… com-
mand. Click the button immediately to the right of the
pop-up menu to zoom out. Click the far right button to
zoom in.
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The Guide Lines
Guide lines serve to help you position elements on a doc-
ument page. You can place guide lines by clicking at the
desired point on the ruler and remove guide lines by
dragging them off the ruler. Clicking on the ruler at the
left gives you horizontal guides, and clicking on the ruler
at the top gives you vertical guides.

The Setup Guides… command in the Arrange menu lets
you create a grid using guide lines or set guide lines that
mark margins, columns, or other points. When you create
guides in the Setup Guides dialog box, the guide lines
automatically appear on the rulers.

Guide lines only appear on the page where you originally
set them. To have guide lines appear on many pages of a
document, you need to place them on a master spread.

Note: You cannot place guides when you have an active
text block in your document. To place guides,
deactivate the text block or select the Arrow tool
on the Tools palette.

User’s Guide

The Guide Snap Toggle control always appears in the
upper left corner of the Document Window. When you
activate the “snapping” feature, the gray rectangle bor-
ders the crossing lines. When you deactivate the “snap-
ping” feature, the gray rectangle appears offset from the
crossing lines.

Turning guide snap on tells to align elements
against guides. Placing an element within the specified
distance of a guide with the Toggle turned on aligns the
element against that guide. Likewise, creating or resizing
an element near a guide causes the element's dimensions
to snap to the guide. The Guide Snap Toggle also lets you
align elements along their horizontal and vertical center
axes.

You can set the sensitivity of the Guide Snap Toggle in
the Guides dialog box in the Arrange menu. Simply enter
the distance from a guide that you want elements to sit
before they snap. By default, assumes a dis-
tance of 1/4 inch.

The Guide Snap Toggle

Snap on

Snap off
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The scroll bars and scroll boxes appear along the right
side and the bottom of the Document Window. A scroll
box appears somewhere between the two scroll arrow but-
tons at the end of the scroll bars. The position of the
scroll box represents your current position in the docu-
ment’s total viewing area.

To move within the document’s viewing area, click on one
of the scroll arrow buttons or click and drag on a scroll
box. Dragging a scroll box moves you across the viewing
area quickly. Clicking on a scroll arrow button moves you
more slowly. You can move incrementally by clicking on
the scroll bar. Clicking on the scroll bar moves you one
window length at a time.

The Scroll Bars and Scroll Boxes

The Zoom Box
The Zoom Box appears in the upper right corner of the
Document Window. Clicking the Zoom Box resizes the
Document Window to take advantage of your monitor’s
screen area. Clicking the Zoom Box a second time
restores the document to its original size.

The Window Resizing Box
Located in the lower right-hand corner of the Document
Window, the Window Resizing box works exactly like it
does in other Macintosh applications. By clicking and
dragging on the Window Resizing Box, you can adjust the
size of the Document Window.

If you have selected the Fit in Window command in the
View menu before resizing the window, auto-
matically fits the document to the new size. 
remembers the size and position of the Document
Window when you save your work.

Multi-Ad Creator2

Ruler Zero Points
The Guide Snap Toggle also allows you to set ruler zero
points. When you click and drag from the Guide Snap
Toggle into the Document Area, the vertical and horizon-
tal lines appear (they cross at your pointer). When you
release the mouse, the zero point on the vertical and hori-
zontal rulers move to the selected point. To reset the
default, press the Command key while clicking on the
Guide Snap Toggle.
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The Close Box
The close box appears in the upper left corner of the
Document Window. Clicking the close box closes the cur-
rent document. If you haven’t saved your changes, 

asks you if you want to do so.
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USING CREATOR2 PALETTES

The Arrangement palette lets you manipulate the posi-
tion of elements. Although you can control and manipu-
late elements from the Arrange menu, the Arrangement
palette provides icon buttons for the most commonly used
commands. This makes it easier and quicker to manipu-
late elements on a document page.

The Arrangement Palette

Align
left

Align
center
(vertical)

Align
right

Justify 
horizontal
spacing

Flip
horizontal

Bring to
front

Send to
back

Align
top

Align center
(horizontal)

Align
bottom

Justify
vertical
spacing

Flip 
vertical

Many of your activities in are performed from
palettes. These palettes organize frequently used com-
mands and needed information into floating windows
that you can move about the screen. Although a palette is
always available, you can remove—or hide—one until you
need it by deselecting the appropriate command in the
View menu. You can display hidden palettes by choosing
the appropriate command from the View menu.

provides a number of palettes to help you
design a document. For example, the Tools palette con-
tains a number of buttons for creating documents and
modifying elements. The Element Specs palette informs
you of the position and measurements of elements. The
Files palette lets you reference text and graphic files.
More palettes exist to aid you in your work. You can find
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The commands available as icons on the Arrangement
palette include:

• Align left
The Align left icon aligns all selected elements
along their left edge.

• Align top
The Align top icon aligns all selected elements
along their top edge.

• Align center (vertical)
The Align center (vertical) icon aligns all
selected elements along their vertical axis.

• Align center (horizontal)
The Align center (horizontal) icon aligns all
selected elements along their horizontal axis.

• Align right
The Align right icon aligns all selected elements
along their right edge.

• Align bottom
The Align bottom icon aligns all selected ele-
ments along their left edge.

• Justify vertical spacing
The Justify vertical spacing icon places an
equal amount of vertical spacing between all
selected elements.

• Justify horizontal spacing
The Justify horizontal spacing icon places an
equal amount of horizontal spacing between
selected elements.

• Flip horizontal
The Flip horizontal icon flips all selected ele-
ments along their horizontal axis.

• Flip vertical
The Flip vertical icon flips all selected elements
along their vertical axis.
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The three icon buttons at the top of the Colors palette rep-
resent, from left to right, the Frame icon, the Fill icon,
and the Shadow icon. The text field to the right of the
Shadow icon serves as the Shade field. A Shade pop-up
menu also appears next to the Shade field. You can choose
a shade percentage from this pop-up menu too.

Multi-Ad Creator2

• Send to back
The Send to back icon sends all selected items
behind any elements over which they are placed.

• Bring to front
The Bring to front icon brings all selected items
buried behind other elements to the front.

The Colors Palette
The Colors palette lets you manipulate an element’s color.
You can set a color for an element’s fill (inside), an ele-
ment’s frame (outside), or an element’s shadow. Each
attribute has its own icon button on the Colors palette.
When you click on an icon, the appropriate attribute color
for the selected element appears highlighted in the scroll
list. The palette also lets you shade a color by selecting a
percentage from the Shade pop-up menu.

If you like, you can rearrange the order of colors on the
Colors palette. Simply drag the chosen color to the place
where you want it to appear on the list. When you drag a
color, a highlighted line appears in place of the selected
color. You can place the highlighted line between the two
entries where you want the selected color to appear.

Note: You cannot move the first four colors (None , Black ,
Whit e, and Registration ) on the palette.

You can close the Colors palette by clicking in its close
box or deselecting Colors in the View menu.

Colors Palette Controls

The Frame
button

The Fill
button

The Shadow
button

The Shade
field

The Shade
pop-up
menu
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lets you assign a color to a few imported
graphic types. To assign a color to a graphic, select the
graphic and click on a color from the Colors palette. You
can assign:

• A single color to black and white EPS images

• A foreground and background color to black and
white TIFF images

Assigning Colors to Imported Graphics

A black frame, white fill, and no shadow serves as the
default setting for any element. To change a color of an
element:

1. Click on the element you want to color.

2. Click on the proper icon from the Colors palette to
select frame, fill, or shadow.

3. Select the desired color from the color list.

All colors initially appear shaded at 100 percent. To pro-
duce a lighter shade, type in the percentage or click on
the pop-up arrow and select a percentage from the list
that appears. 

Notice that the icon buttons on the Colors palette change
into letters when you edit text. 

Although the icons function in the same way, their func-
tions now apply to selected text. For example, to change
the shadow color of shadowed text:

1. Click and drag across the shadowed text with the I-
beam to select it.

2. Click the Shadow icon on the Colors palette.

3. Choose a new color from the scroll list on the Colors
palette. Notice the shadow color of the selected text
now changes.
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Modifying the Colors List

A color list appears with every new document. You can
add or delete colors with the Colors… command in the
Document menu. Every modification you make in the
Colors from document namedialog box is saved to the
document file. The Export… button lets you save the
color list as an independent file. This lets you share a
modified color list with other people or to reuse a color
list in another document.

You can add spot colors from a placed EPS graphic to the
Colors palette. automatically adds spot colors
to the color list if you have selected the Add spot colors t o
palett e option in the Preferences dialog box.
also lets you add spot colors on a file-by-file basis from
each placed EPS file’s dialog box. 

You can also print the spot colors from EPS files as
process colors by selecting the Print spots as process
option in each file’s dialog box. Or, you can select the Set
spots as process option in the Preferences dialog box.

also automatically adds colors to the color list
when you paste an element from the clipboard or a
Scrapbook file. When you paste an element from outside
the document, recognizes the colors used and
adds any new colors to the color list. This lets you share a
Scrapbook file of an element from your work.

• A foreground color to element-based PICT images

• A foreground and background color to bitmap
PICT images
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You also can set and add Grayscale, RGB, CMYK,
Focoltone ID and Swatch, NAA-COLOR, and PANTONE
colors to the colors list. To add or modify a color, choose
the Colors… command from the Edit menu. 

The Colors from document name dialog box appears.

Adding a color

1. Click on the New button in the Colors from docu -
ment name dialog box.

2. Select a model type (RGB, CMYK, Grayscale, etc.)
from the scroll box.

3. Select a color. Some models, like the Focoltone mod-
els, have designated color options. If you have
selected one of these models, simply click on a color.
Other models, like the RGB model, let you create col-
ors. If you have selected one of these models, you can
enter color values into text fields, or click and drag on
slide bars, until you have a color you like.

4. Enter a color name. If you choose a spot color, it prob-
ably already has a name. You can use this name or
choose one of your own.
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5. Click the OK button to add the color to the color list.
This returns you to the Colors from document name
dialog box.

Making a spot colo r

1. Select a color in the Colors from document name
dialog box.

2. Click the Edit button.

3. Click the Spot radio button.

4. Click the OK button.

Note: Spot colorsappear in italic type on the Colors
palette.

Editing an existing color

1. Select the color you want to modify in the Colors
from document name dialog box.

2. Click the Edit button.

3. Modify the color according to your wishes. Notice that
matches the color you have chosen to edit

with the appropriate color model.

4. Enter a new name for the color if you wish.

5. Click the OK button to add the edited color to the
Colors palette and to return to the Colors from doc-
ument name dialog box.

Note: If you change an existing color, Creator2 auto-
matically applies your changes to each use of
that color in your document.

Adding colors from a previously saved color file

1. Click the Import… button in the Colors from docu -
ment name dialog box.

2. Locate the color file that contains the files you want
to use.
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3. Double-click on the color file name. This adds the col-
ors in the file to your document. does not
add colors that already appear on your Colors palette.

Saving colors

1. Click the Export… button in the Colors from docu -
ment name dialog box.

2. Select the location where you want to save your color
list.

3. Enter a name for the color file.

4. Click the Save button. This saves your color list as a
stand-alone file. While still saves a color
list with the document, you can use this stand-alone
file in other documents. Simply import it
in the Colors from Document Name dialog box.

The Element Specs Palette

The Element Specs palette gives you information about
the dimensions of any element you have selected. The
palette also lets you manipulate the dimensions of ele-
ments simply by entering the desired values into the
appropriate fields. This method of manipulating elements
offers more precision than a drawing tool.

If you want, you can hide the Element Specs palette by
clicking its close box or by deselecting the Element Specs
command in the View menu.
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The Files palette may prove helpful if you make frequent
changes to a document or if you work on documents with
many placed graphics and imported text files. Not only
does the Files palette let you make a reference list of
files, but you can place files into a document directly from
the palette.

The top of the Files palette contains three icon buttons.
These icons let you take advantage of every task the File
palette can perform. These icons include, from left to
right: the Open icon, the Delete icon, and the Place icon.

The Open icon opens a file dialog box that lets you add
files to the Files palette. To add a graphic file, click the
Arrow tool on the Tools palette. To add a text file, click
the Text tool on the Tools palette. The Open icon changes
to represent the type of file you want to add to the Files
palette.

The Delete icon removes a selected file name from the list. 

You can remove all the files on the palette by pressing the
Shif t key while clicking the Delete icon. You can remove
multiple files by pressing the Command key while clicking
on the names of the files you want to select and then
clicking the Delete icon. 

The Place icon lets you place files on the palette in a
specified location. The Place icon changes to represent the
type of file you selected.

The Files Palette

Open graphic
file icon

Open text file
icon

Delete
icon 

Place graphic
file icon

Place text
file icon
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You can add files to the Files palette in one of four ways: 

Click the Open icon to open a file dialog. Locate and click
on the file you want to import, then click on the Add file
to palette button. This places the file name on the Files
palette. Clicking the Add all Files button adds every file
name in the current directory to the Files palette. This is
useful if you have all the files you need in one location.
When you have finished, click the Cancel button to
return to the Document Window.

You can also place files into the Files palette using the
Place Graphic… command and the Import Text… com-
mand in the File menu. When the dialog boxes for these
selections appear, just click the Add file to palette button.

You can place files on the Files palette by dragging them
directly from the desktop. To do this, select the Keep Files
Palette visible while in background check box in the
General panel of the Preferences dialog box in the Edit
menu. If you don't have this check box selected,

hides the Files palette when you go to the
Finder.

Finally, you can send references from Multi-Ad Search to
. For more information on sending references,

see Appendix E of the Reference Manual.

When you look at a file name in the Files palette, you
may notice a symbol to the left of the file name. This
symbol refers to the file type. denotes EPS,
PICT, bitmap, TIFF and text files. 

also tells you when you have placed a file by
putting check mark ( ) next to the file name of the palette.

Placing a graphics file from the Files palette

1. Click on a file name to select it.

Using the Files Palette

PICT files EPS files

Bitmap, TIFF, GIF
and other files

Text files
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The Styles Palette
The Styles palette displays four different kinds of styles:
type styles, paragraph styles, style models, and element
styles.  The Styles palette also shows you the keyboard
shortcuts, if any, that exist for each style. 

Selecting a Style type

You can view the different styles available by clicking on
the icon buttons at the top of the Styles palette. Each
icon represents certain types of formatting text:

• Type Styles
Type styles apply text characteristics to letters
and words. For example, type styles control font
type, font size, leading, and other characteristics.

• Paragraph Styles
Paragraph styles apply formatting attributes to
whole sections of text. For example, paragraph
styles control margins, tabs, hyphenation, quad
leaders, and other formatting attributes. A para-
graph style can also apply a type style.

• Style Models
Style models apply sequencesof text characteris-
tics and formatting attributes to text. For exam-

2. Click on the Place button on the Files palette and
move the arrow pointer to the Document Window.
The pointer becomes a crosshair with a graphics sym-
bol. Click and drag in the area where you want the
graphic to appear.

Or

Click on a file name and drag to the location where
you want the graphic to appear.

Double-clicking on a file name

Double-clicking on a file brings different results depend-
ing on the type of file you have selected.

• Double-clicking on a graphic file centers the
image on the visible document page.

• Double-clicking on a text file displays the Break
Text dialog box.
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The Tools Palette
The Tools palette contains the tools you need to create
elements in . With these tools, you can create
or modify text or graphics. By selecting an element with a
tool from the Tool palette, you can easily manipulate the
appearance of any item on a page.

The Drawing/Creation Tools

You can create a variety of elements with the Tools
palette. You can find the drawing/creation tools—with the
exception of the Text tool—grouped together in the bot-
tom two rows of the Tools palette. You can find the Text
tool on the first row of the palette. By selecting the appro-
priate drawing/creation tool, you can make:

• Borders

• Freehand drawings

• Lines

• Path shapes

ple, Style models control the appearance of tabu-
lated lists and other information with special for-
matting needs. A style model can apply to both
type and paragraph styles.

• Element Styles
Element styles apply graphic characteristics to
elements. For example, element styles control
frame point size, color, shading, shadow, and
other characteristics.

You can change the order of the style names by dragging a
style name to a new location on the palette. For more
information about styles, refer to the appropriate section
of the Reference Manual.

Applying a style

1. Click the icon of the style type you want to use.

2. Select the text or element you want to style.

3. Click on the name of the style you want to apply.
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The Freehand Drawing Tool

Create freehand drawings by selecting the Freehand
Drawing tool from the Tools palette. Move the arrow
pointer to the Document Window, and it turns into a pen-
cil pointer. Click and drag the mouse in the Document
Window. Notice the pencil leaves a line that traces its
path.

The Line Tool

Create lines by selecting the Line tool from the Tools
palette. Move the arrow pointer to the Document
Window, and it turns into a crosshair. Click and drag in
the Document Window to form a line. Pressing the Shif t
key while dragging restricts a line to horizontal, vertical,
or 45° angle plans.

The Path Tool

Similar to the Line tool, the Path tool lets you create
straight and curved paths. Create paths by selecting the
Path tool from the Tools palette. Move the arrow pointer
to the Document Window, and it turns into a pen pointer.
Now, click in the Document Window. Release the mouse
button and move the pointer. Notice that a line extends
from the point of your first click to the tip of the pen
pointer. Click at the next point on your path, thereby
making a nonsmoothing path point.

To make a closed path, click on the starting point. To
make an open path, double-click at the point where you
want the path to end. To make a curved line, click and
drag in the direction of the curve.

The Border Tool

Create borders by selecting the Border tool from the Tool
palette. Move the arrow pointer to the Document Window,
and it turns into a crosshair. Click and drag in the
Document Window to form the frame of the border. To cre-
ate a square border, press the Shif t key while dragging.
Double-click on the Border tool to open the Border
Chooser dialog box.

• Ovals

• Rectangles

• Starbursts

• Text blocks
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The Starburst Tool

Create starbursts by selecting the Starburst tool from the
Tool palette. Move the arrow pointer to the Document
Window, and it turns into a crosshair. Click and drag in
the Document Window to form the frame of a starburst.
Pressing the Shif t key while dragging creates a starburst
with a proportional height and width.

The Text Tool

The Text tool serves as the primary tool for placing and
editing text. To create text blocks, click and drag in the
Document Window with the Text tool. When you release
the mouse button, a new text block appears. To create a
text block on top of an existing text block, press the
Option key while dragging with the Text tool. Just like
any other element, handles appear on the corners and
sides of the text block frame. You can adjust the size of
the text box by dragging on the handles with the Text
tool.

When you make a text block, a blinking cursor—the
insertion point—appears in the block’s top left corner.

uses standard Macintosh editing techniques.
To familiarize yourself with editing text, refer to your
Macintosh documentation.

The Rectangle Tool

Create squares and rectangles by selecting the Rectangle
tool from the Tool palette. Move the arrow pointer to the
Document Window, and it turns into a crosshair. Click
and drag in the Document Window to form the frame of a
rectangle. To create a square, press the Shif t key while
dragging.

The Oval Tool

Create circles and ovals by selecting the Oval tool from
the Tools palette. Move the arrow pointer to the Document
Window, and it turns into a crosshair. Click and drag in
the Document Window to form the frame of an oval. To
create a circle, press the Shif t key while dragging.
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The Modification Tools

The Tools palette also contains a number of tools for mod-
ifying the appearance of elements. You can find the modi-
fication tools grouped together in the first two rows of the
Tools palette. The modification tools on the palette
include the:

• Arrow tool

• Containment tool

• Cropping tool

• Reshape tool

• Rotate tool

• Skew tool

• Flip tool

The Arrow Tool

Clicking the Arrow tool changes the pointer to the famil-
iar arrow shape. Use the Arrow tool to:

• Change an element's size

• Select one or more elements

• Drag an element

• Resize an element

• Access an element's dialog box

Should you need more room, you can flow text from one
block to another by clicking the widget at the lower right
of a text block and then dragging a new block.

Widget
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With the Arrow tool, you can select elements in several
ways:

• By clicking

• By dragging a selection rectangle around multiple
elements 

Note: Any item that intersects with a selection
rectangle is also selected.

• By Shif t -clicking to select or deselect multiple ele-
ments

Any element in the Document Window or Desk Area can
be selected, dragged, or resized. Once you have selected
an element, handles (black boxes) appear at the corners
and halfway along the sides of each selected element.

By clicking and holding the Arrow tool over the element’s
frame, you can move the element anywhere on the page
or Desk Area. By pressing the Option key while dragging
elements, you can make a duplicate of the element at
your desired location: the original element remains at its
last location. If you press the Shif t key while clicking on
the item, the element moves in a straight vertical or hori-
zontal line.

You can also click and drag a selected element to other
Document Windows; this copies the element

to the target document. By dragging an element to the
Finder, you create a “clipping file” of that element.
Dragging an element into another application places a
PICT file of the selected element in the application.

Clipping files retain element information as independent
files so you can drag them into other applications.
Dragging an element from the Document Window to the
Finder Trash deletes the element. However, a clipping
file remains in the Trash—until you choose the Empty
Trash command from the Special menu in the Finder—
should you need that element later.

You can resize any element by dragging on its handles.
By pressing the Shif t key and dragging on an element’s
handles, you can resize the element proportionally.

Pressing the Tab key while you have the Arrow tool selected
lets you select the “next element” in a layer. If you have
selected all the elements, pressing Tab deselects all ele-
ments. This feature may prove useful when you want to
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The Containment Tool

The Containment tool lets you place one element inside
the frame of another element. Only those parts of the
contained element visible within the frame can be seen.

Containing elements

1. Click the Containment tool on the Tools palette. Notice
the Arrow pointer becomes outlined.

2. Click on the element you want to place inside another
element. 

3. Drag your element to the element you wish to place it
in. Notice the container element’s frame becomes
bolded as you move your element over it.

4. Position your element within the container.

5. Release the mouse button.

To reposition a contained element, use the Containment
tool to click on the container and drag. To drag a con-
tained element out of a container, click on the element
with the Containment tool and drag the element out of
the container. When you click on a contained element
with the Container tool, the container's frame appears
highlighted. When you remove a contained element, the
container’s frame goes back to normal. 

The Container tool can also drag a selection rectangle if
you click outside an element and drag across it. This
selects elements at the outermost containment level. (You

select elements hidden in a layer or elements on a crowded
page. You can also Command -click to select the “next ele-
ment” in a layer. Using this method, you can only select the
elements directly under the pointer, which may not include
all the elements in a layer.

Double-clicking on an element with the Arrow tool opens a
dialog box for that element. You can also open this dialog
by clicking on an element and choosing the Element Info
command in the Elements menu. This dialog box offers
precise manipulation of the elements they relate to.
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The Cropping Tool

The Cropping tool lets you hide—or crop—parts of
graphic elements (PICT, TIFF, RIFF, EPS, GIF, JPEG,
and MacPaint® elements) for size or aesthetic reasons.
On imported graphics, you can only use the Cropping tool
to crop, not scale. (You can scale a graphic in the Graphics
panel of the Element Info dialog box, in the Elements
menu, with the Cropping tool selected). To scale an ele-
ment, use the Arrow tool.

Cropping lets you remove superfluous details from the
side(s) of an element. You can crop the top, bottom, or
sides of any uncontained graphic. 

To crop:

1. Click on the Cropping tool in the Tools palette. 

2. Position the tool over one of the element’s handles. 

3. Click and drag for the desired effect. 

Clicking inside a graphic with the Cropping tool allows
you to move the graphic around within its cropping frame. 

The Reshape Tool

The Reshape tool provides detailed editing options for
manipulating elements. Selecting an element with the
Reshape tool gives you access to a unique set of handles
that are not available with the other tools. These "reshap-
ing handles" allow direct manipulation of element shapes.
With the Reshape tool, you can:

• Adjust rectangle corner roundness

• Adjust starburst roundness and point depths

• Reshape paths

can also place container elements inside other elements
with the Container tool). Pressing the Option key while
clicking and dragging a container duplicates the element. 

Double-clicking on an element with the Containment tool
opens an element dialog for that element only.
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You can only reshape rectangles, paths, and starbursts.
All other elements display standard handles when
selected with the Reshape tool.

You can select only one element at a time with the
Reshape tool. When you select a path element and one or
more handles with the Reshape tool, clicking outside the
path deselects the handles but leaves the path selected.
To deselect a path element while you have the Reshape
tool selected, you must either select another element or
click another tool on the Tools palette.

Path editing with the Reshape tool

When reshaping a path element, each point on the path
displays a reshaping handle. The appearance of these
reshaping handles—or control points—varies according to
their type. Control points appear as smoothing or non-
smoothing points. You can select individual control points
as well.

Clicking on an unselected path with the Reshape tool
selects it, but notice the control points remain unselected.
An unselected control point appears outlined, while a
selected control point appears solid. Select a control point
by clicking on it. You can select more than one control
point by pressing the Shif t key and clicking on additional
points.

You can also select control points by clicking and drag-
ging a selection rectangle across a path. Points are
selected as soon as the selection rectangle surrounds
them and are deselected as the rectangle moves away.
Pressing the Shif t key while dragging a selection rectan-
gle adds the points selected by the selection rectangle to
those points already selected.

Unsmoothing
control points

Smoothing
control points
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Adding and deleting control points

Clicking on the edge of a path while pressing the
Command key creates a new handle. The type of control
point the handle becomes depends on the type of control
points that surround it. If you place a new handle
between two nonsmoothing control points, the new han-
dle becomes a nonsmoothing control point. If you place a
new handle between two smoothing control points, the
new handle becomes a smoothing control point. If you
insert a new path point between smoothing and non-
smoothing points, by default it becomes a nonsmoothing
point.

You can delete a path point by selecting it and pressing
the Delet e key. You can also delete a control point by
selecting it and then choosing the Clear command from
the Edit menu.

Converting handles between smoothing and non -
smoothing control points

Pressing the Option key while clicking on a control point
toggles its type between smoothing and nonsmoothing.
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Rectangle Editing with the Reshape Tool

Any rectangle, frame, or text block selected with the
Reshape tool displays handles and guidelines that let you
manipulate each corner of the rectangle. You can adjust
both the size and roundness of each corner.

Initially, any changes you make to one corner of a rectan-
gle affect the other corners. However, you can unlink cor-
ners by pressing the Option key while resizing a corner.
You can also unlink a rectangle’s corners by clicking on
the chain buttons in the Rectangle dialog box.

The dialog box also lets you change the appearance of a
rectangle’s corners. You can choose from among four dif-
ferent corner styles: Rounded , Inver ted, Rounded and
Inver ted, and Beveled .

Linked
corners

Unlinked
corner

Unlocked
corner

Corner
types

Locked
corner
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When you select a starburst with the Reshape tool, six
handles and several guidelines appear. Four of the han-
dles manipulate the rectangle that defines the inner area
of the starburst.  The other two handles manipulate the
roundness of the rectangles that define the starburst’s
inner and outer points. The guidelines serve to show the
shape of the inner and outer rectangles and illustrate the
connection between the roundness handles and the cur-
vature of the rectangle’s corners.

Clicking on a side handle of the inner rectangle lets you
drag that side. Pressing the Option key while dragging
causes the opposite side to move symmetrically. Pressing
the Shif t key while dragging causes all four sides to move
symmetrically. Click inside the inner rectangle to drag it
anywhere within the bounds of the outer rectangle.

Clicking on an arrow handle allows you to manipulate
the roundness of the inner or outer rectangle. You can
move these handles both vertically and horizontally.
Pressing the Shif t key while moving these handles allows
you to proportionally adjust vertical and horizontal
roundness.

Starburst Editing with the Reshape Tool

Roundness
handle

Roundness
handle

Side handles

Side handles
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The Rotate Tool

The Rotate tool lets you rotate elements, including graph-
ics and text blocks. You can rotate an element by select-
ing it with the Rotate tool, clicking on a handle, and
dragging it to the desired degree of rotation.

To rotate elements

1. Click on an element with the Rotate tool.

2. Click on a handle of the selected element and drag to
rotate.

Normally rotation occurs around the center of the ele-
ment, or the center of the group of elements, that you
have selected. Pressing the Command key while you click
on an element with the Rotate tool lets you place a rota-
tion point anywhere on the element. Subsequent rota-
tions occur around this point rather than the center of
the selected element.

You can see the outline of elements drawn in 
and masked graphics when you use the Rotate tool on
them. When rotating placed graphics that you have not
masked, you see an outline defined by the element’s
selection handles. 

If you hold down the Shif t key while rotating, the appli-
cation restricts the rotation to 15° increments. 



35User’s Guide

In the Rot text field, in the General Info panel of the
Element Info dialog box in the Elements menu, you can
rotate an element by any degree between -360 degrees
and 360 degrees. Enter negative numbers for counter-
clockwise rotation. You can also adjust element rotation
in the Rot field of the Element Specs palette.

The Skew tool

The Flip Tool

The Flip tool lets you turn an element end over end, or
side over side. The Flip tool does not, however, flip an
item at its point of origin. The tool flips an element
around an imaginary line halfway between where you
originally began the drag and the pointer's current loca-
tion. To flip, you must select an element and then move
the element away from its resting place.

The Skew tool lets you adjust the skew angle of any ele-
ment without changing the length of any of its sides. The
Skew tool can only move two sides of an element at a
time. Note that you cannot move elements with the Skew
tool.

If you hold down the Shif t key while skewing, it restricts
the skew to -45°, 0°, or 45°. 
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WORKING WITH TEXT
provides you with extremely powerful tools for

manipulating text.  As with other applications, you can
format the text’s font, style, and size. However,
offers even more formatting options. You can also apply
precise formats to text: alignment, paragraph indents,
leading, or kerning—even change the case of type (to all
upper case, for example). You can set leading and text
sizes in whole or fractional points. You even can have text
in color or in grayscale. If you use QuickDraw GX™ fonts
in a document, you can style text in even more ways.

You can also search and/or replace text, fonts, styles
and/or sizes. For example, you can change 12-point
Geneva Bold text to 14-point Times Italic Underline text.
You can even copy the format of one section of text to
another section of text, copy the format of a selected
paragraph to another paragraph, and apply type styles,
paragraph styles, and style models to text.

Text Blocks and Widgets
To provide a wide range of text manipulation options,

handles all text as segments of blocks. You
can have text from a single file shown in many blocks.
Each block can have a different size and a different posi-
tion in the document.

Small tabs, called “widgets,” in the lower right corner of
text blocks show the order of text blocks. An ellipsis (…)
appears in a widget if it contains more text than cur-
rently appears. If a text block displays all of its contained
text, an exclamation mark (!) appears in the widget. The
widgets of linked text blocks contain numbers according
to each block’s place in the succession of text.

To create additional blocks:

1. Place the Text tool over a widget. The pointer
becomes an arrow.

2. Click the widget, and the pointer changes to a
crosshair with an ellipsis (+A…).

3. Drag a rectangle with the crosshair. The remaining
text flows into the created block.

+A
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If the new block’s widget displays an ellipsis (…), click its
widget and repeat the process. Keep clicking and creating
new text blocks until a widget displays an exclamation
mark (!).

You can link a new block to any existing block—not just
the last ellipsis (…) or exclamation ( !) block—by clicking
the existing block’s widget before creating the new block.
All your text stays in the correct order and flows through
all your blocks as you’d expect. If you want another block
somewhere, just click on a widget and drag a rectangle.

Multiple Block Selections

To select text in the application, simply click at the begin-
ning of the text you want to select and drag to the end.
You also can select text in linked blocks. To do this, just
drag from one block into another. Select text in intermedi-
ate blocks by dragging across several blocks (from the sec-
ond to the fifth block, for example). If you want to select
all the text in a series of linked boxes, choose the Select
All command from the Edit menu or press Command-A .

Portions of text in unlinked blocks cannot be simultane-
ously selected.

Creating Text from Scratch

lets you enter text from scratch. After you cre-
ate a text block, an I-beam appears in the block’s upper
left corner. Choose the desired font, style, or font size for
the text in from the appropriate menu. Now start typing.
If you have much text to type, you might make one large
block, enter all of the text, and then “re-block” after
you’ve created the text.

Styling Text
has many ways to format text, including some

standard Macintosh formatting methods. For example, to
change the appearance of text, simply select some text
and choose a new font from the Font menu. In addition to
these standard features, also uses powerful
text styling methods unique to itself.
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When you first type in a text block, the resulting text
appears in the current default font. The current default
font also appears when you import text into a text block.
To change the default font:

1. Choose the Document Settings… command from the
Document menu.

2. Click on the Text panel.

3. Choose a new font from the pop-up menu.

4. Click the OK button to save your settings and return to
the Document Window. Click the Revert button to
restore your last saved settings. Click the Default but-
ton to return to its default font. Click the
Cancel button to discard all changes.

You can also select the type you want for your text by
choosing a font from the Font menu. Then choose a style
and a size from the Style menu and the Size menu. When
you start typing, the text appears in the font, size, and
style you’ve chosen. For example, if you make a new text
block, choose Times from the Font menu, Embolden from
the Style menu, and 18 pt from the Size menu. Then
begin typing. If you don’t choose any options from the
Font, Style, or Size menus, formats the text
according to the settings in the Tex t panel of the
Preferences dialog box in the Edit menu.

Standard Character Styles

Every Macintosh computer has certain “standard character
styles.” In , these standards appear in the Styles
menu. The computer redraws text to apply these styles.

However, many fonts come with the styles already applied.
This lets you choose, for example, the Embolden command
from the Style menu or a Times Bold font from the Font
menu. In general, you can find many popular PostScript
fonts offered in plain, bold, italic, and bold italic styles.
Some fonts may also have versions that are light, heavy,
extra bold, or other variations. Although it usually doesn’t
matter whether you choose a bold font from the Font menu
or choose Embolden from the Style menu, it’s good to
choose the exact font if it’s installed in your system. 

Text Defaults
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Complex Character Formats

In addition to these standard styles, offers
some style commands of its own. These commands
include: Condense, Extend, Superior, Inferior,
Superscript, Subscript, Upper case, Lower case,
Underline, Outline, and Shadow.

Saving Time in Character Formatting

If you want to use this same character format on other
sections of text in your document, you can create your
own text style that includes all these attributes.

offers several ways to set the character format.

If you only want to use the format once:

1. Select the text.

2. Choose the Copy Char Specs command from the Edit
menu.

3. Select the range of text ot which you want to apply
character attributes.

You can apply many attributes to characters. Consider
this text:

The attributes here are:

• Times, 14 pt
• italic
• bold
• kerned, a bit
• greater-than-standard word spacing

Although the text contains several attributes, the format-
ting remains consistent throughout the text—it’s all the
same font, same size, and so forth. To create this text,
you performed six separate actions.

“People of Europe, today the soldiers and
sailors of the Allied expeditionary forces
have embarked upon the great crusade.”
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4. Choose the Paste Char Specs command from the Edit
menu. This applies the character attributes to the
highlighted text.

If you plan to use the text style many times, you can
establish your own type style. You can then use your cus-
tomized type style multiple times, based on the desired
character attributes. If you want to create a type style:

1. Select the text with the character attributes.

2. Choose the Make Type Style… command from the
Format menu. The Edit Type Style dialog box opens.
The settings reflect the selected text. You can accept
these settings or make more changes in this dialog
box.

3. Name the type style. 

4. Click the OK button. The new type style now appears
on your Styles palette.

To reuse a type style, simply select a range of text in a
text block and click on the name of the desired type style
name in the Styles palette. The selected text takes on the
attributes of the chosen type style.

Type styles can save you a lot of time. Use them when-
ever you need to repeatedly use the same text attributes.
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Paragraph Attributes

Select the Paragraph… command from the Format
menu. The Paragraph dialog box opens.

Styling Paragraphs
In addition to type styles, also lets you create
styles that apply a consistent look to paragraphs. These
paragraph styles let you set tabs, indents, paragraph
alignments, and other formatting options.

defines paragraphs by return characters (¶).
By pressing the Return key, you make a paragraph. To
view the return characters in your document, choose the
Document Settings command from the Document menu
and select the General panel. Select the Returns and new -
lines check box.

Paragraph Defaults

When you first make a text block, there are two default
paragraph settings—paragraph alignment and hyphen-
ation. You can find these settings by choosing the
Document Settings… command in the Document menu
and selecting the Tex t panel.

Choose left, right, centered, or justified for a default para-
graph setting. You can turn hyphenation on or off.

sets all other paragraph values to zero—no
indents, no space before or after a paragraph, and no tabs. 
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Disregard, for now, the Type style pop-up and the items at
the top of the dialog box. What we’re concerned with are
the settings for attributes that involve paragraphs. It’s
important to remember that the settings apply to entire
paragraphs. 

Now let’s format a paragraph to look like this:

Use the Paragraph dialog box to make the changes:

You only need to make two changes. Enter 1/4” into the
Lef t indent box and change the Af ter ¶ to 4 pt. Click the
Apply button to view your changes. When completely fin-
ished, click the OK button to approve your changes and
return to the Document Window.
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If you want to use the same paragraph format on other
sections of text, you can create your own paragraph style
that includes these attributes. As with character attrib-
utes, offers several ways to set paragraph for-
matting.

Use the Copy ¶ Specs command and the Paste ¶ Specs
command to copy the attributes of one paragraph to
another. If you want to copy a paragraph’s format to mul-
tiple sections of text, then make a paragraph style.

1. Click an insertion point in the paragraph containing
the attributes you wish to reuse. Since paragraph set-
tings remain consistent for each individual para-
graph, you don’t need to select the entire paragraph.
Just click in the desired paragraph.

2. Choose the Make ¶ Style… command from the
Format menu.

The settings reflect those of the paragraph containing
your insertion point. You can accept these settings or
make more changes in the dialog box. You might, for
example, add tabs by clicking on the ruler and set a
character to be used for a tab ruler.

Saving Time in Paragraph Formatting
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Using Type Styles with ¶ Styles

Another powerful use for styles presents itself when you
combine type styles with paragraph styles.

Here’s one example. Say you’ve made a type style named
Bookman with these characteristics:

3. Name the new paragraph style, and—optionally—
choose a Shift-Option keyboard equivalent.

4. Click the OK button.

5. The new paragraph style appears on the Styles
palette. If you made a keyboard equivalent, that
appears as well.

You can apply the paragraph style by clicking in a para-
graph and then clicking on the name of the style in the
Styles palette or typing the keyboard shortcut you have
assigned.
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You want to make a model that includes both type and
paragraph information. You can include the type style in
the paragraph style by using the Type Style pop-up in the
Edit Paragraph Style dialog box:

When you next apply Book style , formats the
text using the paragraph settings and the type settings
contained in the Bookman type style.

Using the “Based on” Pop-up Menu

Using the Based on pop-up menu in the Type Style dialog
box and the ¶ Style dialog box lets you build on existing
styles to create new styles.

For example, say you have a type style named Bookman
with these attributes:

• Font: Bookman

• Style: Italic

• Size: 12 pt



46 Multi-Ad Creator2

To make a new type style that includes all the character-
istics of Bookman, but has one additional attribute:

1. Choose the Make Type Style command from the
Format menu.

2. Use the Based on pop-up to choose Bookman .

3. Make changes to the existing style.

4. Name the new type style.

5. Click the OK button to place your type style on the
Styles palette. Click the Cancel button to discard
your changes.

Using the Based on pop-up menu, you can quickly create
sets of type styles and paragraph styles.

Style Models
Now that you have applied both type and paragraph styles
to text, you’re ready to apply sequences of type and para-
graph formats to a text selection. lets you cre-
ate style models to accomplish this. A style model may also
apply both paragraph styles and type styles.

Consider a simple food listing. Drag a new text block and
type the following in a 12 pt font:

What you really want is this:

To create such a line, type the text in 12 pt again and fol-
low the steps below to format it. Make sure you select the
Invisibles check box in the General panel of the Document
Settings dialog box in the Document menu.
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1. Change the font size of Onions 49¢ to 18 pt. Make
sure you include the space after the cents symbol as
18 pt.

2. Set a tab after Onions .

3. Set a tab leader in the tab ruler.

4. Make the cents symbol superior.

You want to use this format many times, but you can’t
use a type style because the formats aren’t consistent for
the entire line. Both the size and the style change
throughout the line.

You can’t use a paragraph style, because although the
line ends with a return, what you’re looking for isn’t so
much a paragraph style (with the exception of the tab and
Tab leader) as a type style. Actually, it’s a sequence of
type styles—perfect to capture as a style model.

1. Begin to make your style model by selecting the
entire line.

2. Choose the Make Style Model… command from the
Format menu. The Edit Style Model dialog box
appears. Notice dialog box settings reflect the charac-
teristics of the selected text. Paragraph formats
appear in bold. Below the paragraph formats are the
type formats.
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3. Double-click on the line Paragraph 1 - Left… (or sin-
gle-click and then click Edit) to see a detailed view of
the paragraph.

4. Click the OK button to return to the Edit Style Model
dialog box. The five lines under the Paragraph 1 line
are type formats.

5. Double-click on any of these lines to open the
Character dialog box. If you want, you can further
edit the style in this dialog box, as shown above. 

6. Click the OK button to place the style model on the
Styles palette. Click the Cancel button to discard
your changes. 

The new style model appears in the Styles palette.

To use the new style model, select some text then click
the style model’s name in the Styles palette.
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supports several file formats directly. You can
import these formats quickly and easily. Moreover, these
formats will be updated as new versions of the programs
that create them appear. supports:

• text files

• Microsoft’s RTF (Rich Text Format)

Note: Using RTF lets you place formatted Word
(or any RTF) files produced on MS-DOS
computers.

• Text-Only files

• SimpleText files

also takes advantage of the Translation
Manager/Mac Easy Open to import an even wider variety
of text documents. Through the Translation Manager/Mac
Easy Open, you can access MacLink Plus translators.
These translators convert documents from one specific for-
mat into another specific format. MacLink Plus translators
only import text and word processing documents; they do
not import graphic files.

Placing text into a new or existing block

1. Click the Text tool in the Tools palette.

2. Drag to create a new, empty text block.

3. Choose the Import Text… command from the File
menu.

4. Select a text file. Make sure you haven't selected the
Place with cursor check box.

5. Click the Place button. The text flows into the block
beginning at the insertion point. You can also set an
insertion point in an existing text block. Place your
insertion point at the spot where you want the
imported text placed and then import the file.

Placing text with the pointer

1. Choose the Import Text… command from the File
menu.

Placing Text
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2. Select the Place with cursor option in the Import
Text dialog box.

3. Select a text file and click the Place button.

4. Drag a new text block.

5. Release the mouse button, and the text flows into the
new block.

Placing Text with No Options Selected
The application also provides an easy method for placing
text, but with no user controls. Make sure you have no
file options selected.

1. Choose the Import Text… command from the File
menu and select a file. 

2. Click the Import button. The file appears in a new
text block created in the center of the window.

Placing Text Using the Files Palette

lets you use the Files palette to place files
directly from the Files palette. This lets you keep a
record of the files you need and which ones you have
used.

1. Choose Import Text… from the File menu.

2. Select a text file to import.

3. Click the Add file to palette button to place the text
file into the Files palette. If you want to add all the
text files listed in the current directory, click the Add
all Files button.

4. Click the Done button.

5. Double-click on the text file’s name in the Files
palette. This loads the pointer with the text.

6. Drag a text block within your document. The text
flows into that text block you have placed.

Text only files are formatted during placement to the cur-
rent default font, alignment, and size. You can set the
default font, size, and alignment in the Tex t panel of the
Preferences dialog box in the Edit menu. 
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Selecting Text
Select the Text tool, which changes the pointer to an A
with a crosshair (+A). Move the pointer into the text
block, and it changes to an I-beam. With this I-beam
pointer you can:

• Click to set an insertion point

• Click and drag to select a range of characters

• Shif t -click and drag to extend the current selection

• Double-click to select a word

• Double-click and drag to select a range of words

• Triple-click to select an entire line

• Quadruple-click (four quick clicks) to select an
entire paragraph

Breaking Text into Blocks
The Break Tex t option lets you place text into more than
one text block and then place each receiving text block on
the page.

To use the Break Tex t feature, prepare a text file in your
word processor, or export a text file from . Insert
delimiters into your text; these characters let the applica-
tion know at what point to send text into a new block. You
can use any character not otherwise used in the text.
Standard delimiters include \, ^, ~, and so on. You can
also break text after a specified number of paragraphs (¶).

After inserting the delimiters, save your file and quit the
word processing application. Complete the following steps.

1. Choose the Import Text… command from the File
menu. The Import Text dialog box opens.

2. Select the text file to import.

3. Click the Break button. The Break Text dialog box
appears. 

4. Type in your delimiter. Here, we used a backslash, so
a backslash character appears in the Characters field.
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5. Select the Delet e box if you want every instance of
this character stripped from the text blocks as

places the blocks. 

6. Click the Place button. A dialog box appears.

7. Click the OK button.

8. Click and drag to create the first text block. All text
before the first delimiter flows into the text block.
Continue to create text blocks until you have placed
all the text from the selected file. 

The Status Area tells you the number of blocks you have
left to place.

To cancel after placing any text block, press Command-. or
choose the Import Text… command from the File menu.
This cancels the remaining blocks.

Using Break Text with Existing Text Blocks

also provides a fast, efficient way to use Break
Tex t . Instead of dragging text blocks as the text comes in,
you can put the text into existing text blocks.

1. Create empty text blocks. Create as many blocks as
you have sections of text. 

2. Set the Break Text dialog box using a text file you’ve
already prepared.

3. Click the Place button.

4. Move the pointer over one of the empty text blocks
and hold down the Command key.

For still more speed, create empty text blocks using the
Make Matrix command, found in the Edit menu. Make
one empty block, then choose Make Matrix to replicate
rows and/or columns of empty text blocks. Now break text
as before, remembering to press the Command key while
clicking in an empty text box.
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Tabs
Since space size varies according to font, size, or style,
positioning text—like in columns—becomes difficult.
Tabs, however, let you mark a fixed location on a line. No
matter what font, size, or style you use, the tab remains
exactly where you set it.

Pressing the Tab key inserts a tab character into the text.
Normally invisible, you can view tab characters by select-
ing the Tabs and Quads check box in the General panel of
the Document Settings dialog box in the Document menu.
Any tabs or quads you place in text now become visible.

The Tab Ruler

The tab ruler appears if you’ve chosen the Show Rulers
command from the View menu and clicked on a text
block with the Text tool. When you display the Tab Ruler,
you automatically select the entire paragraph that con-
tains the insertion point. This serves to remind you that
changes to the Tab Ruler affect entire paragraphs.

Tab settings affect one paragraph or a series of para-
graphs. If you like, you can use Select All, or press
Command-A , to have tab settings affect all text. A para-
graph, however, is the smallest unit that the Tab Ruler
controls. If you want different tab settings on a line-by-
line basis, place a return character at the end of each line
to form separate paragraphs.

You can set the units on the Tab Ruler in the General
panel of the Preferences dialog box in the Edit menu.
Select your vertical and horizontal units from the pop-up
menu. If you choose picas for units, picas appear on the
ruler.

Using the Tab Ruler

First Line Indent
marker

Left Indent marker

The first line indent marker is the small triangle at the
top left of the ruler. sets the default value to
zero. To set a first line indent for a paragraph, drag the
marker to the right.
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The left indent marker is the small triangle below the first
line indent marker at the left of the ruler. It controls the
indentation for all lines except the first line in every para-
graph. As with other markers, drag it to change indenta-
tion. sets this default value to zero, too.

The right indent marker is the triangle at the right of the
ruler. It controls right indentation of all lines in the para-
graph (or paragraphs, if more than one is selected). Drag
to set an indentation. The default setting for right indent
is snug against the right side of the text block.

You can also set indentation by choosing the
Paragraph… command from the Format menu. The
General panel of the Paragraph dialog box lets you set
the indentation for the selected paragraph by entering
values in the First , Lef t , and Right fields.

If you prefer to use the Paragraph dialog box to set indents,
click the Apply button to check the appearance of your set-
tings. Confirm your changes by clicking the OK button.

Setting a Tab Stop

To set a tab stop at the location of your choice:

1. Move the pointer over the bottom half of the tab
ruler. The pointer changes to an arrow.

2. Click the tab ruler to set a tab stop.

Always start by creating left tabs; the left tab serves as
the default. Notice that tabbed text now moves over to line
up with the tab stop on the ruler. If you want to move the
tab stop, simply click and drag on the tab triangle.

Default Tabs

You can, of course, simply use the default tabs to put tabs
in text, but the default tabs have drawbacks. When you
use the default tabs, you merely put an eight point wide
space at the tab point. To align text evenly, you need to
use a tab stop.

Right Indent
Marker
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Removing a Tab Stop

To remove a tab stop, just click and drag it off the Tab
Ruler, until it disappears, and release the mouse.

Moving a Tab Stop

To move a tab stop, click on the tab stop and drag it to a
new location.

Tab Ruler Terminology

You can choose from several different types of tabs. These
tab types include: left tabs, right tabs, center tabs, and
decimal tabs. As you might expect, each tab formats text
differently.

To change from one tab stop type to another:

1. Double-click on a tab stop.

2. Select a tab type in the Edit Tab dialog box, and—
optionally—a tab leader character.

Left Tabs

Similar to the familiar typewriter tab, left tabs serve as
the default since they are the most frequently used.
Tabbed text is placed flush left against a left tab marker.

Right Tabs

Right tabs require either a return at the end of the
tabbed line or another tab at the end of a tabbed item.
The first character defines the start of the text that’s
being moved. The second character (return or tab) deter-
mines the end of the text that is being made flush right.

The Type area of the
Edit Tabs dialog box
displays the tab types
available. Select a tab
by clicking on the
appropriate radio but -
ton.
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Center Tabs

Center tabs, like right tabs, also require either a return
at the end of the tabbed line or another tab. The first
character defines the start of the text that’s being moved.
The second character (return or tab) determines where
the text will center.

Decimal Tabs

Choose a decimal tab when you want decimal points to
line up vertically, or when you want to line up text by a
character you specify in the field next to the decimal tab
type. The decimal tab requires a tab character and a
period to determine where the text aligns. In most cases,
the period serves as a decimal point in a number; hence,
the name of the tab.

With decimal tabs, the tab character serves as the first
delimiter and the decimal point (period) usually serves as
the second delimiter. However, decimal tabs align with
any character. Simply enter the different character into
the field next to Decimal: in the Edit Tab dialog box.

Tab Leaders

Tab dots, in most cases, lead to the text at the next tab
stop. assumes a blank tab leader unless other-
wise specified.

When you want to add tab leaders to text which already
has tabs set, double-click the tab stop and the Edit Tab
dialog box appears. Then, select a tab leader, click the OK
button, and a row of characters (according to your choice)
appears in the tabbed space.

Custom Tab Leaders

Because treats tab leaders as text characters,
you can alter them just like other characters. Some possi-
bilities include:

• Superscript, subscript, or other characters.

• Leaders in different fonts and sizes, such as Zapf
Dingbats.

• Horizontally scaled or kerned leaders.
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WORKING WITH GRAPHICS
lets you manipulate two types of graphics:

those graphics you create in the application and those
graphics you import from other sources. can
import graphic files from a wide variety of programs.
Whether you deal with graphics created in other pro-
grams, scanned in by scanning devices, or downloaded
from an on-line service, you can import the images into a

document.

Placing Graphics
The application provides several methods for importing
graphic files into a document. 

Placing Graphics without Options

1. Choose Place Graphic… from the File menu.

2. Make sure you have deselected the Place with cursor
check box.

3. Select a graphic.

4. Click the Place button.

The image appears in the Document Window.

Placing Graphics with the Pointer

1. Choose the Place Graphic… command from the File
menu.

2. Select the Place with cursor check box.

3. Click the Place button. This returns you to the
Document Window, and the pointer changes to a
crosshair with a check box.

4. Click in the document to set the position of the
graphic’s top left corner.

Or

Drag a rectangle in which the graphic can appear. To
scale the image proportionally, press the Shif t key
while dragging a rectangle.
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Graphic File Types

Element Style Sheets
One of 's strengths is its ability to manipulate
graphic elements.  You can adjust the frame, color,
shadow, and other attributes of an element. To increase
your control over the appearance of an element, you can
create element styles. Much like paragraph and text
styles, you can use element styles to ensure the graphics
you create have a consistent appearance.

For example, start by drawing a rectangle. Because you
want to draw people’s attention to the rectangle, you
decide to change the:

• Pen Weight to 2 pt.

• Frame Type to solid double lines

• Frame Color to 100 percent Blue

• Fill Color to 30 percent Red

To use graphics from an outside source in , you
must place—or import—them into the application.

recognizes a variety of different file formats in
order to make this process as easy as possible. Graphic
files that you can place in include:

• DCS 1, DCS 2, EPSF, EPSP, and EPS files

• JPEG and JFIF files

• GIF files

• TIFF files

• Adobe Photoshop® files

• PICT files

• MacPaint files

• border files
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• Shadow offset to 0.1 vertical and 0.1 horizontal

• Shadow to 75 percent Black

Set the appropriate settings in the Pen Weight, Frame
Types, and Shadow Offset dialog boxes in the Elements
menu. Also change the frame color, fill color, and shadow
settings in the Color palette. When you have finished all
seven steps, your rectangle looks exactly how you want it.

Changing seven different attributes doesn’t seem like
much when you want to modify only one rectangle.
Assume you like the appearance of your rectangle so
much that you want to use the same settings on a number
of boxes. For this, you can then create an element style
containing the desired attributes. This lets you use the
same style on multiple elements without having to repeat-
edly set the attributes.

1. Choose the Element Styles… command in the Edit
menu. The Element Styles from document name
dialog box appears.
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2. Click the New button. The Edit Element Style dialog
box now appears.

3. Enter a name for the style you want to create. 

4. Enter your desired attribute settings. All the attrib-
utes you set for your first rectangle can also be set
here.

5. Click the OK button. This returns you the Element
Styles from document name dialog box.

6. Click the Done button. You return to the Document
Window.

7. Click and drag a new rectangle.

8. Choose Styles in the View menu, if the Styles palette
doesn't already appear on the screen.

9. Click the Element Styles button on the Styles
palette. The name of the element style you just cre-
ated appears on the palette.

10. Select the new rectangle and click on your element
style name. The attributes you set in the Element
Style dialog box appear on the new rectangle.
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GLOSSARY OF PRINTING TERMS
Additive color Color produced by combining red,

green, and blue light. When com-
bined in equal amounts, red,
green, and blue produce white
light. Computer monitors and
scanners use this method to pro-
duce color. See alsoSubtractive
color.

Alignment The arrangement of text. You can
choose from four different align-
ment options in —left
(ragged right), right (ragged left),
centered, or justified.

Annotation When referring to text, the adorn-
ments added to characters.

lets you hide annota-
tions or choose from a variety of
different annotations on some
fonts.

Ascender The portion of some lower case let-
ters that extend above the main
body of the character. Letters with
ascenders include b, d, f, etc.

ASCII The American Standard Code for
Information Interchange.
Pronounced “az-kee,” it refers to a
text-only file format supported by
most computer programs on both
Macintosh and Windows comput-
ers.

Banding The visible stepping of shades in a
gradient.

Baseline The invisible line on which letters
and numbers rest.

Bezier curve In , a curve whose
shape is defined by points set
along its arc.

Bitmap graphic A graphic image formed by a grid
of dots or pixels. See alsoVector
graphic.
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Bitmap font A set of characters formed by a
grid of dots or pixels. Fonts con-
tained in the Macintosh System
file are examples of bitmap fonts. 

You must have a separate file for
each size of a bitmapped font that
you want to use. The computer
cannot display or print a bitmap
font accurately without the appro-
priate file.

Bleed An element that extends to the
edge, or over the edge, of a page.

Bullet A character used to add emphasis
to sections of text. Common bullets
include circles (•) or diamonds (♦).

Callout Explanatory text that calls atten-
tion to important features of an
illustration. A thinline—called a
Callout rule—may connect a call-
out to the appropriate part of the
graphic.

Caption The text that identifies an illus-
tration.

Choke The slight reduction in size of the
foreground element’s knockout.
Since the element prints at regu-
lar size, the background color
overlaps the element color.

Cicero A unit of measurement commonly
used in Europe. A cicero measures
approximately 4.55 millimeters.

CIF A Creator Interchange Format
file. Multi-Ad Creator uses this
file format to store document
information. Other programs, like

, may allow you to
import CIF files.

CMYK A four-color process printing sys-
tem using cyan (C), magenta (M),
yellow (Y), and black (K) inks.
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Commercial printers reproduce
other colors using concentrations of
these four inks.

Color bars A strip of color values on a printed
page  used  to  check  printing
quality.

Color separation The process of separating a page’s
colors into components. Spot col-
ors require only one plate for each
color used on a page. Process sep-
arations require four plates (one
each for cyan, magenta, yellow,
and black) for each page.

Column inch A measurement used by newspa-
pers and magazines to calculate
the cost of display advertising. A
column inch is one column wide
by one inch deep.

Control target One-half inch pinwheels designed
by the Graphic Arts Technical
Foundation. The targets help mea-
sure image resolution during plate
production and plate degradation,
dot doubling, grain, and slurring
during printing. 

Crop Trimming the edges of a graphic
to fit inside a specified area. You
may want to crop a graphic to
eliminate an unwanted portion
entirely.

Crop marks Vertical and horizontal lines show-
ing the final dimensions of the
printed page. The remaining paper
is trimmed from the document.

Cursive connection A feature used with cursive fonts.
The Cursive connection feature
lets you either connect cursive
characters, partially connect cur-
sive characters, or disconnect cur-
sive characters.
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Diacritic The accent marks that appear
over characters. In ,
you can choose to display diacrit-
ics as they normally appear, hide
diacritics, or display diacritics sep-
arate from their characters.

DCS 1 A color file format that creates
five PostScript files—C, M, Y, K,
and a data file about the image—
for each graphic.

DCS 2 A color file format similar to DCS
1. Instead of creating five different
PostScript files—like DCS 1—DCS
2 creates one PostScript file con-
taining a file’s color information,
including spot color information.

Decimal tab An option that lets you align num-
bers by their decimal points.

Descender The portion of some lower case let-
ters that falls below the main
body of the character. Letters with
descenders include g, j, p, etc.

Diacritical mark A symbol that, when added to a
letter, indicates a special phonetic
value.

Discretionary hyphen An invisible symbol that marks
the location where you want to
break a specified word. You can
insert discretionary hyphens
directly into text.

Document Window The on-screen window that dis-
plays the document.

Dot leader A row of periods used to fill tab
spaces. Dot leaders are often used
in numerical tables.

Dots per inch The pixel resolution of monitors or
the dot resolution of printers.
Often referred to as dpi.

Ellipsis Three dots (…) used to indicate an
omission of words. To place an
ellipsis in text, press -;.
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In most Macintosh applications,
when an ellipsis follows a menu
item, it indicates that choosing the
item opens a dialog box.

Em dash A dash (—) that has the same
width as the letter M in the given
font. Do not place a space before
or after an em dash. To place an
em dash in text, press -.

Emulsion The photosensitive coating on film
or paper.

En dash A dash (–) that has half the width
of an em dash in the given font.
An en dash is longer than a
hyphen. To place an en dash in
text, press -.

EPS An Encapsulated PostScript file. A
graphics file format that stores
high resolution pictures. An EPS
file contains a PostScript image for
printing and a preview for viewing.

First line indent The distance between the begin-
ning of the first line of a para-
graph and the left indent.

In , a first line value of
zero causes the first line of a para-
graph to begin at the left border of
a text block. If the left indent has
a higher value than the first line
indent, the first line begins to the
right of the left indent. This pro-
duces a hanging indent.

Font A complete set of characters (let-
ters, numbers, etc.) that share a
unified design—or typeface.

Frame The outside limit of an element. In
, you can assign a

frame’s width and style.

French fold A page printed on one side and
then folded at two right angles to
form four pages.
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Gatefold An oversize page where both sides
fold into the gutter in overlapping
layers.

GIF A Graphics Interchange Format
file. A file format developed by
CompuServe Incorporated. to
reduce the amount of time neces-
sary to download bitmap images
from an on-line service. GIF
images have a maximum of 256
colors.

Gradient A smooth blending of one color
into another.

Grayscale image A graphic that displays shades of
gray by containing more than one
bit of information per pixel.

Gutter The central blank area between
left and right pages.

Hairline A line that measures .25 points. 

Halftone screen A photograph of a graphic shot
through a screen. The resulting
image is composed of many small
dots or other elements.

Handles Small black squares that appear
on elements. You can use a handle
to resize an element.

Hanging indent Created when the first line of a
paragraph extends to the left of
all other lines in a paragraph.

HSB HSB is a system used by artists to
represent colors. Hue (H) refers to
the color pigment, Saturation (S)
refers to the concentration of the
pigment, and Brightness (B) refers
to the amount of black in a color.

Hyphenation Dividing a word by syllables at
the end of a line.
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Invisible characters Characters that you can view in
but do not appear on a

printout. Invisible characters
include discretionary hyphens,
new lines, returns, tabs, quads,
and spaces.

JPEG A Joint Photographic Experts
Group file. JPEGs provide full-
color bitmap images in a highly
compressed file format. 
can import grayscale, RGB, and
CMYK JPEG files.

Jump lines Page number references that
guide a reader through an article.

Justification Text with even left and right mar-
gins. See alsoAlignment.

Kerning The adjustment of space before
characters.See also Tracking.

Knockout A blank shape that appears in a
color. An element of the same
shape but of a different color even-
tually fills the knockout space.

Landscape The orientation of a page that is
wider than it is tall. See also
Portrait.

Leader Any character (usually periods or
dashed lines) used to lead the
reader’s eye across the page.
Leaders commonly fill tab stops.

Leading The space between lines of text,
usually measured in points.

Left-aligned A paragraph with a straight left
edge and a ragged right edge.

Left indent The distance between the left bor-
der of a text block and the begin-
ning of a line.

Ligature A pair of combined letters. Some
ligatures include æ, œ, and fi.
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Lines per inch A measure of the frequency of a
halftone screen. Commonly
referred to as lpi.

Margin The space between the edge of the
page and the document area
reserved for text and graphic ele-
ments.

Mask Traditionally, the material used to
block off a portion of a printed
page. In desktop publishing, it
refers to the area of an image that
is cut away.

Masthead The section containing the pub-
lishing and staff information. 

Master spread A nonprinting page that contains
the basic page design for the docu-
ment. You can place both text and
graphic elements on a master
spread.

Misregistration Misregistration, or out of registra-
tion, occurs when the foreground
element and its knockout do not
exactly match. This leaves white
gaps between an element and its
background color.

Moiré pattern The undesirable pattern created
when two or more screens are
superimposed.

Offset The distance of an element from
some point.

Ornament Special characters that appear in
addition to the letters and num-
bers of a font.  For example, some
fonts may have fleurons, decora-
tive borders, international sym-
bols, math symbols, or musical
symbols.

Orphan The first line of a paragraph that
falls at the bottom of a column.
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Overprint The process of printing one color
on top of another. If the back-
ground color is darker than the
foreground element, the back-
ground color may show through
the foreground element, changing
its color. Also called a surprint.

Page Ornaments The elements printers use to align
and compose pages. Typical page
ornaments include registration
marks, crop marks, and color bars.

Pica A basic unit of typographic mea-
surement. There are 6 picas to an
inch. Each pica contains 12 points.

PICT A common Macintosh file format
for bitmap images.

Pixel Condensed from “picture element,”
pixel refers to the smallest part of
a picture that a monitor or printer
can display.

See alsoBitmap.

Point A basic unit of typographic mea-
surement. There are 12 points to a
pica and 72 points to an inch.

Portrait The orientation of a page that is
taller than it is wide. 

See also Landscape.

PostScript A page description language cre-
ated by Adobe Systems,
Incorporated. PostScript describes
fonts and graphics and how they
appear on a page.

PostScript error An error that occurs when the
PostScript interpreter, usually a
printer, cannot continue processing
a PostScript program. For exam-
ple, the interpreter may not recog-
nize a specific PostScript com-
mand, or the command may exceed
some limit of the interpreter.
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Pixels per inch A measure of monitor resolution.

Printer driver A file provided by Apple
Computer, Incorporated and other
companies that let your computer
communicate, or “drive,” the
printer. To use printer drivers,
place them inside the Ex tensions
folder in the System folder.

Process color A color produced by combining dif-
ferent concentrations of cyan,
magenta, yellow, and black ink.
See alsoCMYK, color separation,
and spot color.

Registration color A color applied when you want an
element to print on all color sepa-
ration plates. For example, crop
marks print on all plates if you
apply registration color.

Registration mark Small crosshairs printed outside
the page image area. Printers use
these marks to align overlaying
color separations. 

See alsoColor separations.

Reshape handles Small white boxes that you can
use to change the shape of ele-
ments. Reshape handles appear
when you click on certain ele-
ments—like rectangles, star-
bursts, and paths—with the
Reshape tool. 

RGB A system for representing colors
using red (R), green (G), and blue
(B) light. The RGB system is used
by computer monitors, scanners,
and other color light systems.

Right-aligned A paragraph with a straight right
edge and a ragged left edge.

Right indent The distance between the right
edge of a text block and the right
edge of text.



71User’s Guide

Rule A line placed on a page.

Scale The process of changing the pro-
portion of an element.

Scalable font A mathematically described font.
You can print scalable fonts at any
size without jagged edges.

Screen angles The angles used to offset the differ-
ent film layers in process color sep-
arations. Properly aligned screen
angles reduce moiré patterns.

Screen frequency The number of lines or dots in a
halftone screen.

Sidebar A short article set apart from
another longer, related article.
Sidebars usually appear in shaded
or framed boxes.

Smooth Rounding the corners of rectan-
gles, freehand drawings, or other
elements.

Spot color A color printed with a single ink.
Useful in documents with less
than three colors. See alsoProcess
color and Color separation.

Spread The slight enlargement of a fore-
ground element. Since the ele-
ment’s knockout prints at regular
size, the element’s color slightly
overlaps that of the background
color.

Subtractive color Color produced by combining
cyan, magenta, and yellow ink.
Printers use these three colors to
reproduce all other visible colors.

In theory, combining cyan,
magenta, and yellow ink in equal
amounts produces black. Since all
inks contain impurities, printers
typically use a black ink in addi-
tion to the three other colors.

See alsoAdditive color and CMYK.
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Swash The elaborate italic letters usually
used at the beginning of sections
or for initials.

Tab stop The location to which the inser-
tion point jumps when you press
the Tab key.

Thumbnail A small image of a page. Thumb-
nails allow you to see the general
layout of several pages at once.

TIFF A Tag Image File Format that
stores scanned graphic images.
TIFFs can be black and white,
grayscale, or color images.

Tiling Breaking a document page into
sections to fit the paper size avail-
able. You then assemble the page
sections manually.

Tracking The adjustment of space after
characters. See alsoKerning.

Trapping The intentional overlapping of
adjacent colors to prevent misreg-
istration. See alsoChoke,
Knockout, Misregistration,
Overprint, and Spread.

Two-fold A publication design that produces
a total of six panels, three on a
side, each defined by a fold.

Type family A group of fonts with related
design elements. Examples of type
families include Century,
Helvetica, and Times.

Unsmooth Removing smoothed corners from
a rectangle, freehand drawing, or
other element. See alsoSmooth.

Vertical substitution The changing of certain characters
in vertical runs of text.

Vector graphic A graphic image composed of
mathematically described paths.
See alsoBitmap graphic.
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White space The area of a document that con-
tains no text or graphic elements.

Widow The last line of a paragraph that
appears on a line by itself.

Word wrap The adjustment of the number of
words on a line to fit the margins.
Word wrapped lines have “soft”
returns. places a “soft”
return at the end of a line of text
when you have typed beyond the
available space. This allows you to
continue typing on the next line.

A “hard” return is created only by
pressing the Return key.

WYSIWYG What You See Is What You Get
(pronounced “wizzy-wig”) refers to
the reproduction of a printed page
on a computer screen. A true
WYSIWYG display accurately
shows the final appearance of a
printed page.

X-height The x-height is the height of the
main body of text, excluding the
ascenders and descenders.
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